
Mobile development
Android overview

http://www.android.com/ 

http://www.android.com/


Total PC shipments in 2010, 346.2 million
In Q4 2010 it shipped 101 million smart phones

All shipments numbers are in million units
according to International Data Corporation (IDC)



http://www.dagensmedia.se/nyheter/dig/article3081018.ece

According to the CEO of the 
Swedish operator Telia 
Sonera
In quarter 4 - 2010 were 90% 
of all mobile phones sold a 
smartphone! 

Source: asymco.com



Todays mobile ”tele-puters”
• Sophisticeted

– Have capacity and functionality as a desktop computer (view the 
Mozilla Seabird movie or Motorola ATRIX docks promo)

– GPS and other sensor devices built in, voice recognition...
– Low cost unlimited data-plan
– TV (dvb-h/mbms, dmb/dab)
– Pay services (NFC) 

• Examples
– 3rd party applications (apps)
– Cloud computing services
– Advanced communications
– OpenGL ES etc. 
– Location Based Services
– VoIP, speech to text, ...



Examples - LBS
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• Others
– Java(2) ME
– Microbrowser 

based
– Flash (Lite)
– Python
– BREW



Mobile development 2



http://en.wikipedia.org/wiki/Mobile_programming
for even more info

A very good read: ”Mobile Developers 
Guide To The Galaxy”
http://www.enough.de/products/mobile-
developers-guide/

Android compared to other
development environments 
and platforms

Missing platforms
HP - webOS
… ?

Mobile Dev. 3

http://en.wikipedia.org/wiki/Mobile_programming


What is Android?
• A free, open source mobile platform framework
• Android is not a device, or a product, or limited to 

phones
• A hardware reference design describing the minimum 

requirements to support the stack
• Android brings Internet-style innovation and 

openness to mobile phones
• Contains a set of pre-installed key applications (a 

fully functioning smart phone)
• Software Development Kit (tools, plug-ins, and 

documentation)
• The online Android Dev Guide

• http://developer.android.com/guide/



Android history
• July 2005, Google buy Android Inc. of Andy Rubin
• Jan 2007, Apple release Iphone with the help of Google
• Nov 2007, Open Handset Alliance is created
• Oct 2008, Android is open source (Apache license)
• Apr 2009, Android 1.5 (API level 3 ) Cupcake is released
• Sep 2009, Android 1.6 (API level 4) Donut is ...
• Jan 2010, Android 2.1 (API lelvel 7) Eclair is ...
• May 2010, Android 2.2 (API level 8) Froyo is ...
• Dec 2010, Android 2.3 (API level 9) Gingerbread is ...
• Feb 2011, Android 3.0 (API level 11) Honeycomb is ...
• Oct 2011, Android 4.0 (API level 14) Ice Cream Sandwich 

is released



Android tablets



Android version 
distribution and 
activations

http://developer.android.com/resources/dashboard/platform-versions.html

There is around 190 million Android 
devices running in the world just now – 
oct. 2011
It cost $25 (one time fee) to publish 
Apps on the Android Market



Android operating system 1
• Android is a Linux based, multiprocess, multithreaded OS

– By default each App runs in its own isolated process with its own Java 
Virtual Machine

– Each App is assigned a unique Linux user ID
– Apps (tasks) can share the same user ID to see each other’s files and 

share the same VM
• Open source libraries
• Android run time environment

– The DVM (Dalvik Virtual Machine) uses APK (Android Package) files 
which are created in the DEX (Dalvik Executable) binary format

– Register based instead of stack based VM with JIT support
• An application framework SDK with a Java 5 SE programming 

interface
– Android NDK for native code (C/C++) via JNI (Java Native Interface)

• Some pre-installed key applications

http://developer.android.com/videos



Android application model



Android stack (architecture)



Android operating system 2
• Android-supported hardware shares some common features 

due to the nature of the operating system
– Phones, tablets, televisions, cars, cameras, ...?

• The Android OS is organized into the following images
– Bootloader - Initiates loading of the boot image during startup
– Boot image - Kernel and RAMdisk (root file system tree)
– System image - Android operating system platform and apps
– Data image - User data saved across power cycles
– Recovery image - Files used for rebuilding or updating the 

system
– Radio image - Files of the radio stack

• These images are stored on nonvolatile flash memory, so they 
are protected when the device powers down.The flash memory 
is used like read-only memory (hence, some call it ROM), but 
can it be rewritten as necessary. For example, with FOTA 
(Firmware Over-The-Air) Android operating system updates



”Old” generation phones
• A couple of popular phones, note that the ROM (Flash) is divided 

into several partitions (images) mounted in the RAMdisk tree
– System, data, etc.

 



At least 5 MF of SoC
- Samsung
- Qualcomm
- Texas Instruments
- nVidia
- ST-Ericsson

”Current” generation of system-on-chip (SoC) boards

NFC
A-GPS



User input methods
• Touch screens

– Resisteive - Two resistive material layers sit on top of a glass 
screen.When a finger, stylus, or any object applies pressure, the 
two layers touch together and the location of the touch can be 
determined

– Capacitive - A charged material layer is overlaid on a glass 
screen.When a finger or any conductive object touches the layer, 
some charge is drawn off, changing the capacitance, which is 
measured to determine the location of the touch.

– Surface Acoustic Wave - This uses a more advanced method 
that sends and receives ultrasonic waves

• Alternative methods
– D-pad (directional pad) - An up-down-right-left type of joystick
– Trackball - A rolling ball acting as a pointing device that is 

similar to a mouse
– Trackpad - A special rectangular surface acting as a pointing 

device
– Keyboard - As it sounds, a minimal keyboard for phones 

 



Sensors in Android
• Apart from the obvious as microphone and one 

or two cameras most phones contain
• Three axis accelerometer to measure gravity
• Three axis magnometer to measure magnetic fields
• Temperature sensor for measuring ambient temperature
• GPS (Global Position System)
• Barometer (air pressure)

– Increase the GPS performance and possibly predict weather
• Light sensor to optimize the display - conserve energy 
• Proximity sensor - used when talking 
• Gyroscope sensor to allow more accurate 

movement in 3D than an accelerometer
– Allows the calculation of orientation and rotation

 



The Java model
Java source code

Java compiler

J virtual machine

Windows/Linux

PC with x86 CPU

J virtual machine

Mac OS X

Mac*

K virtual machine

Rex/OSE/Symbian
Linux/WindowsMobile

Mobile Phone

Model copied 
by Microsoft 
with  .NET

K is for 
kilobyte!

Libraries

Java byte code



Java platforms



Android SDK classes



Whats needed to develop?
• The Android ”tool chain”

– Java SE JDK/JRE 5, 6, 7 (1.5.x – 1.7.x) or newer
– Android SDK and tools

• Build, test and debug the Android applications
– Eclipse IDE or other Java IDE

• Eclipse IDE for Java Developers 3.7.x (Indigo)
• Android Development Tools (ADT) plugin for Eclipse

• Debug certificate
– [drive]:\Users\<username>\.android\debug.keystore

• Various other extra/special tools (not needed in our 
programming labs) as Ant, advanced testing tools etc.

– Fastboot, Proguard, Hierarchy Viewer, etc.
– Monkeyrunner for stress tests, TraceView for profiling etc.

• The first Android lab may have more info (system setup)



Android SDK and tools folders
• SDK Manager and AVD Manager
• The Android Emulator

– A virtual implementation of an Android phone (QEMU)
– AVD (Android Virtual Device)

• Dalvik Debug Monitoring Service (DDMS) 
– Manage and control the Apps, GPS, SMS, calls, etc.
– LogCat (see logged messages), file explorer, etc.

• Android Debug Bridge (ADB) 
– Manage the state of an emulator instance or Android-powered device 

• Copy files, install compiled application packages, run shell commands etc.

• Traceview
– Graphical analysis tool for viewing the trace logs from the Android application, i.e. 

debug your application and profile its performance
• SQLite command tool 
• MkSDCard

– Creates a SD Card disk image to be used for external storage
• Zipalign (done automatically by ADT in Eclipse)

– Optimize the created and signed .apk file, aligning the bytes to 4 



Eclipse with Android SDK - Java

 R.java -This file is automatically generated by Android Developer Tools and 
"connects" the visual resources to the Java source code, we never touch it ourselves

 res - Externalization of strings and graphics many other resource types

 layout - Contains the visual elements or resources in xml, for use by Android activities

 AndroidManifest.xml - This file contains all general information about the application

AVD/SDK manager
Window > Open 
Perspective



Eclipse with Android SDK - DDMS

 Emulator control, File Explorer etc.

 Remember to select the desired emulator/phone in Devices

 Process control is possible if a process is selected

 LogCat



Eclipse with Android SDK - Debug

 Remember to start with the debug button!

 Debug controls

 Breakpoint



Run or debug on-device
• You need to enable your device to 

install Android applications other 
than those from the Android Market

– Menu > Settings > Applications > 
check (enable) the option called 
Unknown Sources

• Menu > Settings > Applications > 
Development

– USB Debugging: This setting enables 
you to debug your applications via the 
USB connection.

– Stay Awake: This convenient setting 
keeps the phone from sleeping in the 
middle of your development work, as 
long as the device is plugged in.

– Allow Mock Locations: This setting 
enables you to send mock location 
information to the phone for 
development purposes and is very 
convenient for applications using 
location-based services (LBS).



SDK and AVD manager



Steps to create your first app
• Assuming you have a working development installation
• In Eclipse select File > New Project > Android Project
• Give a project name and select a build target (an AVD 

must exist)
• Enter application info details - give a package name



Hello World
// HelloWorldMIDlet.java
import javax.microedition.midlet.*;
import javax.microedition.lcdui.*; 

public class HelloWorldMIDlet extends 
MIDlet 
{ 

private Display display; 
private Alert warning;

public HelloWorldMIDlet() 
{ 

warning = new Alert("Hi!", "Hello 
World!", null, null);

display = 
Display.getDisplay(this); 

}

 // Lifecycle methods
public void destroyApp(boolean 

unconditional) { } 
public void pauseApp() { } 
public void startApp() { 

display.setCurrent(warning); 
}

}

package se.du.helloandroid;
import android.app.Activity;
import android.os.Bundle;
import android.widget.TextView;

public class HelloAndroidActivity extends Activity {
   private TextView mTV1;
/** Called when the activity is first created. */ 

@Override
   public void onCreate(Bundle savedInstanceState) 
   {
     super.onCreate(savedInstanceState);

// alt.1 via layout in XML
setContentView(R.layout.main);
mTV1 = (TextView) findViewById(R.id.textView1);
mTV1.setText(R.string.hello_android);

     // alt.2 via Java code
     TextView tv = new TextView(this);
     tv.setText("Hello, Android");
     setContentView(tv);
   }
// the other lifecycle methods
// use @Override for all

public void onStart() {super.onStart();}
public void onRestart() {super.onRestart();} 
public void onResume() {super.onResume();}
public void onPause() {super.onPause();}
public void onStop() {super.onStop();}
public void onDestroy() {super.onDestroy();}

}



Project > Build and Run



AndroidManifest.xml



[res] layout/main.xml

Id = @+id/textView1



[res] layout/main.xml and values/strings.xml

<?xml version="1.0" encoding="utf-8"?>
<resources>

    <string name="hello">Hello World, HelloAndroidActivity!</string>
    <string name="app_name">HelloAndroid</string>
    <string name="hello_android">Hello, Android</string>

</resources>

<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
    android:layout_width="fill_parent"
    android:layout_height="fill_parent"
    android:orientation="vertical" >

    <TextView
        android:id="@+id/textView1"
        android:layout_width="fill_parent"
        android:layout_height="wrap_content"
        android:text="@string/hello_android" />
</LinearLayout>



Difference C# vs. Java?
• Marginal differences

– CLR vs. JVM
– ASP .NET vs Servlets
– WinForms vs. Applets

• Inheritance
– Multiple inheritance is not supported by either language

• Operators and control flow
– Operator overloading and goto (removed in java) otherwise similar
• Exception handling
– Not as forced in C# as in Java
• Multithreading
– More simplified in C#, must synchronize with monitor and mutex class

• Read more...
– http://en.wikipedia.org/wiki/Comparison_of_C_Sharp_and_Java 

import library;
class Hello {
    public static void main(String args[]) {
        System.out.println("HelloWorld"); } 
}

using  library;
class Hello {
    public static void Main() {
        Console.WriteLine("Hello world"); } 
}

http://www.25hoursaday.com/CsharpVsJava.html  

A Java programmer just do this:
public synchronized void methodName() {...}

http://en.wikipedia.org/wiki/Comparison_of_C_Sharp_and_Java
http://www.25hoursaday.com/CsharpVsJava.html


Android application 
package (apk) build process

android.jar
maps.jar

md5

keytool or

ProGuard

• Can be done by hand from the command line
• Android Asset Packaging Tool (aapt)



ProGuard

The ProGuard tool shrinks, optimizes, and obfuscates your code by removing unused code and 
renaming classes, fields, and methods with semantically obscure names. The result is a smaller 
sized .apk file that is more difficult to reverse engineer.

Enable ProGuard with the proguard.config property in the <project_root>/default.properties file.
proguard.config=proguard.cfg

http://developer.android.com/guide/developing/tools/proguard.html

Android SDK tools revision 12-14 has problem with ProGuard
http://code.google.com/p/android/issues/detail?id=18359



Android emulator

Rotate view
Ctrl-F11/F12



Emulator Control



Eclipse and Android SDK
• The emulator only needs to be started once!
• Eclipse IDE for Java Developers 32/64 bit and Java 

JDK 32/64 bit must match
• Java not found? 

– eclipse.exe -vm "C:\Program Files\Java\jre6\bin\javaw".
• Sometimes import android.R; is wrongly imported into 

your source especially when copy and pasting code. 
• To force IntelliSense press Ctrl + Space at certain 

places for a pop-up list with syntax and method 
proposals.

• Try out some of the SDK samples in C:\android-sdk-
windows\samples\API-LEVEL if you want. 

– You need to create a new project from existing sample 
in the New Android Project dialogue in this case.

• Android SDK environment variables
– Path=c:\android-sdk-windows\tools;c:\android-sdk-

windows\platform-tools;c:\Program 
Files\Java\jdk1.6.0_26\bin

– "ANDROID_SDK_HOME"="H:"



Web resources
• Java, Eclipse, Android, and Web Programming Tutorials

– http://www.vogella.de/
• Android Developer Pages

– http://developer.android.com/
• Stack Overflow Discussion Threads

– http://stackoverflow.com/
• http://www.swedroid.se/
• http://www.anddev.org/
• http://en.wikipedia.org/wiki/Android_

%28operating_system%29
• Bygg din egen Android-app

– http://www.idg.se/2.1085/1.327186/bygg-din-egen-
android-app
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